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1. Overview 
QSO Card Creator is a desktop application designed for amateur radio operators to manage 

contacts and generate QSL cards using ADIF logs. This program was developed to assist me 

in confirming my QSO contacts on amateur radio. The application allows for the import of 

standard ADIF files from other loggers or through UDP capture. and annotating its database 

with which contacts have been sent QSL cards by this program. Each ADIF import is 

appended to the application’s database.  

The application allows for Import, Export, Editing, and deletion of records, and utilizes an 

SQLite database for fast and accurate access.  A QRZ membership of XML or above is 

required to obtain the email address of your contact for the purpose of sending an 

electronic copy of your QSL card. Your contacts have the option to opt out of receiving 

QSOCardCreator cards by adding “NOQSOCC” or “NOEQSL” to the QSL information field on 

their callsign update page on QRZ. A version of the program is available for MacOS, 

Windows11, and Unix.  

You have the option to design your own card for use with this application. A JPG file with a 

resolution of 1800 x 1200 at 300 dpi yields the most satisfactory results, particularly when 

borderless printing is considered. A starter.pdf file, serving as a template, is provided within 

the program directory. Each graphic QSO file must be accompanied by a configuration file 

with a .icf file extension. An ICF editor is part of the program and can aid in the creation of 

the ICF file. The configuration file contains the font, font size, styling, and the x, y 

coordinates of the contact data (4). The program allows for the positioning of contact data 

around the image, but the image must be present. The .icf file enables three (3) free-style 

text (FST) entries, along with settings for the font, font size, font color, and X, Y coordinates 

for the text on the image. If the FST, or any other field, is not intended to be printed on your 

image, set the X coordinates to zero (0). For instance, if your card uses frequency but not 

band, send BAND_X:0 in the image configuration file, and the band will not be printed.  

I have a template for Photoshop that I use to create images. If you require assistance in 

creating an image, please seek help on our Facebook page, or contact me. There are also 

videos to assist you at n1et.com. While the program setup may be somewhat challenging, 

once it is operational, it becomes straightforward. Once you have installed the program on 

your machine, I can provide you with a comprehensive overview of its functionality. This 

version of QSOCardCreator adds a contacts database editor and a ICF file editor. 

The program marks the sending of the QSO card by placing “Mailed” in the field called status 

within its database. Within the program, there is a checkbox to exclude all records of 

previously sent QSO cards (6). This checkbox is saved in the setup file, and when checked, it 

will only show the contacts that have not yet sent a card. When unchecked, all contacts are 

shown in the grid. Double-clicking on the QSOFlags cell will allow you to change it. 
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The card menu provides a function to flag a selected record as unsent.  To mark a record as 

unsent, you must be on that record. Therefore, the exclude sent checkbox must be 

unchecked for you to see the record. Additionally, there is an option to set the sent flag of a 

record without sending an email by pressing its shortcut key or using the menu item.  The 

send email option on the card menu performs the same function as the send button on the 

form. The save option on the card menu creates, but does not send, a card by email.  

The One Time Test Email option intercepts outgoing mail and sends it to the email address 

specified in setup as the test recipient. Unlike the Test Mode checkbox, no log entries are 

made, and it is only for that single email. You can blacklist or un-blacklist a callsign on the 

Cards menu. If some contact does not want your cards, you can search for their callsign and 

then activate the menu choice or shortcut key. They will be added to your blacklist. You will 

not be able to send to that callsign unless you remove them from the blacklist by searching 

for them and using remove callsign from the blacklist. You can view who is on the Blacklist 

by viewing Blacklist or clicking on that menu item on the log menu.  

The column headers of the grid allow for sorting of the contacts. Click on a header once to 

select and again to sort. Each click will change between ascending and descending order. 

This sort order is saved to the settings file. Selecting multiple rows in the grid and pressing 

the Send key will batch process the records. This operation is memory-intensive, so it is 

recommended to process only 50 records at a time.  

Selecting multiple rows in the grid will allow for batch mode in most functions such as Bulk 

Clear flag and Bulk Set flag on the Tools menu, as well as in the sending of mail. Please 

exercise caution when using this option.  

On the Tools menu, there is an option to Save System Files. This option will prompt you to 

select a location and copy the setup configuration file, blacklist, Log, cards and database to a 

directory named QSOCardCreatorSysFileBackup in the specified location. 

The program has UPD integration with any program capable of sending WSJT log messages, 

such as SDR-Control or WSJT-x itself. For POTA purposes, it also has integration with FLRig 

to get the Frequency, Power, Band and mode from the radio. 
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2. Quick Start 
1. Configure QRZ and Email (Setup) 

2. Import ADIF (File → Import ADIF) 

3. Select a QSL card (Cards → Select Card) 

4. Select contacts (Standard selection methods) 

5. Click Send E-Mail 

3. Main Window 
 

 

Figure 1 – Main Window 

 

The main window is separated into three main sections (See figure1), which are the live 

card preview (1), QRZ lookup panel (2), and the contact grid (3).  The controls on the main 

screen are what you will use most often. The general practice is to work the contacts, export 

from the logger and import into QSOCardCreator. If the Exclude Sent checkbox (9) is 

checked, you will only see those needing to be sent. As each record is sent, the status is  
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updated and the record is removed from the grid. The object is to keep the grid empty. If 

you need to see all records, simply uncheck Exclude Sent. You can click the Status column of 

the grid to manually change the status of that record. Below is a list of the other controls 

accessible from this main screen. 

 

1.  QSO Card Image. 

2.   QRZ downloaded data. 

3.   Contact Grid. 

4.   Status Falg 

5.   Send E-Mail button – Will send a mail to the contact of the current row or run batch if 

multiple records are selected. 

6.   Search – Conducts a search of the records currently in the grid. 

7.   Comment – This pulldown will allow you to pick the default comment which comes from 

setup, a one-time comment which will go with the current send and then revert back to 

default, or a temporary comment which stays till you return by selecting default, 

8.   Custom comment – Allows you to add, delete, or select a comment to use See Figure 5, 

9.   Exclude Sent – When checked you see only the records with a blank status, while 

unchecked shows you all records. 

10. Edit record button opens the ADIF editor and allows you to change the data and fill in 

missing data for the card. This function also can be used as a basic logger, with the records 

later exported in a ADIF file to be imported into your main logger.  

11. Select Card button shows you the cards available and lets you select the one to use. 

12. QRZ Data button – Allow you to view the data received from QRZ. The key acts as a 

toggle. 

13. Card data section which shows the QSO data. The ICF file decides what gets shown on 

the card using a X,Y coordinate system. A X value of zero will prevent that detail from 

showing.  
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4. ICF Editor 
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Figure 2 – ICF Editor 

The ICF Editor allows precise placement of text elements on your card using X/Y 

coordinates. You click on the image and get an estimate of the coordinates needed and type 

in those values into the X or Y field for the element. An easier way is to position your cursor 

in the X or Y textbox and use your left and right arrow keys to move a pixel at a time. Shift 

and arrow will move 10 pixels at a time. You can be in the X oy Y box and use the Arrows 

(Left, Right, Up or Down) to move the data.  

If starting with a new card, you can load an existing Image Configuration File (ICF) where 

the data box is located where you want the new card to have it, load the new image and save 

the ICF file with a different name. If you are adjusting an existing file, load it in, adjust, and 

then overwrite the old ICF.   
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5. ADIF Editor 

 

Figure 3 – ADIF Editor 

 

You reach this editor by pressing the Log button on the main screen. The data for the 

currently selected grid record will be preloaded in the edit fields. When creating a new 

record, the program will prevent duplicates from being saved. This can be used as a basic 

logger.at your base station. 
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6. Preferences/Settings 
 

 

 

Figure 4 – Settings 
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Configure application behavior and email. Be sure to use the Save System Files on the Setup 

menu after updating the settings. You can edit the default e-mail body text from here, but it 

is easier for the setup menu item. 

7. Card Selection 
 

 

Figure 5 -Card Selection 

 

Choose your card design. This option saves the chosen directory to the settings file. Always 

keep the image file and ICF files together. 
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8. Custom Comments 
 

 

 

Figure 6 – Custom Comments 

Manage reusable comments. Global variables can be used in your comments and will be 

replaced with the true data when used. See the appendices for the global variables available.   
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9. Edit Default Message body 
 

 

This is the text that makes up the body of the e-mail. You can insert any of the Global 

Variables on the right and they will be replaced with real test from the QRZ XML download. 

For example, if you look at the HTML output above, you can see that the name came from 

the use of <QRZFName>  
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10. Integration 

 

Besides allowing for the import of ADIF files, the application can also be configured as an 

UDP listener to capture the Logging information straight from WSJT, Grid Tracker 2, SDR 

Control for Mac, or any application that can transmit/format WSJT UDP messages. This 

application can also forward received packets for use by others. 
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11. POTA 
 

 
 

You should fill in the POTA park info and then save the Activation profile. You can press the 

Read FLRig button to get the data from the radio if using FLRig. If you are doing a SSB park 

activation, after filling and saving the activation profile, just enter the call, RST/R, RST/S, 

and park number for a park to park. If they have more than one park, separate each with a 

comma and a record will be written for each park. Their gridsquare and yours are looked up 

for the park in the downloadd all parks file from the POTA site. Occasionally update that file 

from the menu option Tools/Update POTA Parks Database. If you are combining Digital and 

voice for the activation, just lease the POTA window open and use WSJT or whatever you 

are using. If QSOCardCreatorXV is configured to listen to UDP correctly, all digital contacts 

with be associated with that POTA activation. When complete, use the menu option: 

File/Export ADIF/Export Current POTA activation. You can then upload that file to the 

POTA site, as well as import it into your master logger for sending to QRZ, LOTW, 

Clublog..etc. On the Tools menu there is an option to map the ADIF file. 
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Appendix A – Keyboard Shortcuts 
QSO Card Creator XV supports keyboard shortcuts on both macOS and Windows. 

General 

Mac Windows Action 
⌘Q Ctrl+Q Exit Application 
⌘A Ctrl+A Select All Contacts 

Cards Menu 

Mac Windows Action 
⌘E Ctrl+E Send E-Mail 
F2 F2 Clear Sent Flag 
F3 F3 Set Sent Flag 
⌘S Ctrl+S Save Card Image 
⌘P Ctrl+P Print Card 
F5 F5 One-Time Test E-Mail 
⌘M Ctrl+M Manually Enter E-Mail 
F7 F7 QRZ Data 
⌃⌘B Ctrl+Shift+B Add to Blacklist 
⌃⌥⌘B Ctrl+Alt+Shift+B Remove from Blacklist 

File Menu 

Mac Windows Action 
⌘O Ctrl+O Import ADIF 
⌥⌘E Ctrl+Alt+E Export ADIF (Whole Log) 
⇧⌥⌘E Ctrl+Shift+Alt+E Export ADIF (Selected 

Records) 
⌥⌘C Ctrl+Alt+C Export Log to CSV 
⌘D Ctrl+D ADIF Database Editor 
⌘L Ctrl+L Show File Locations 
⌃⌘I Ctrl+Shift+I Clear Imported ADI Records 

Setup Menu 

Mac Windows Action 
⌘, Ctrl+, Preferences 
⌃⌘S Ctrl+Shift+S Save System Files 
⌃⌘R Ctrl+Shift+R Restore Setup File 
⌃⌘M Ctrl+Shift+M Edit Message Body 
⌘B Ctrl+B Blacklist Maintenance 

Tools Menu 

Mac Windows Action 
⌘H Ctrl+H Sent Cards History 
⇧⌘F2 Ctrl+Shift+F2 Bulk Clear Flag 
⇧⌘F3 Ctrl+Shift+F3 Bulk Set Flag 
⌃⌘K Ctrl+Shift+K Rebuild / Compact Keys 
⌃⌘N Ctrl+Shift+N Edit Card Layout 
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⌃⌘E Ctrl+Shift+E Edit Current Card Layout 
Logs Menu 

Mac Windows Action 
⌘F11 Ctrl+F11 Open Log File 
⌥⌘L Ctrl+Alt+L Send Log File 
⇧⌘F10 Ctrl+Shift+F10 Clear Log 

Help Menu 

Mac Windows Action 
F1 F1 User’s Manual 
⇧F1 Shift+F1 QSO Flag Legend 
⌃F1 Ctrl+F1 Global Variables 
⌥⌘W Ctrl+Alt+W Website 
⌥⌘U Ctrl+Alt+U Check for Updates 

Notes 

macOS uses ⌘ (Command), ⌥ (Option), ⇧ (Shift), and ⌃ (Control). 

Windows uses Ctrl, Alt, and Shift equivalents. 

Shortcut behavior may vary slightly depending on keyboard layout and system 

configuration. 
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Appendix B – ICF File Layout 
The ICF file controls how QSO data is displayed on the card image. All coordinates are in 

pixels from the top-left corner. 

Core Settings 

Setting Description 
IMAGEFILE Card image path 
MAXCOMMENTLEN Max comment length 

Font & Style Settings 

Setting Description 
INFOFONT Font name 
INFOFONTSIZE Font size 
INFOFONTSTYLE REGULAR, BOLD, ITALIC 
INFOFONTCOLOR Color or HEX 

Field Padding 

Setting Description 
CALLSIGN_PAD Padding 
MONTH_PAD Padding 
DAY_PAD Padding 
YEAR_PAD Padding 
TIME_PAD Padding 
BAND_PAD Padding 
MODE_PAD Padding 
RST_PAD Padding 

Position Fields 

Field X Y 
Callsign CALLSIGN_X CALLSIGN_Y 
Month MONTH_X MONTH_Y 
Day DAY_X DAY_Y 
Year YEAR_X YEAR_Y 
Time TIME_X TIME_Y 
Band BAND_X BAND_Y 
Mode MODE_X MODE_Y 
RST RST_X RST_Y 
Comment COMMENT_X COMMENT_Y 

Optional Fields 

Field X Y 
Frequency FREQ_X FREQ_Y 
Power PWR_X PWR_Y 
RST Received RSTR_X RSTR_Y 
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Their Park THEIR_PARK_X THEIR_PARK_Y 
Your Park YOUR_PARK_X YOUR_PARK_Y 
Their Grid THEIR_GRID_X THEIR_GRID_Y 
Your Grid YOUR_GRID_X YOUR_GRID_Y 

Free Style Text (FST) 

Setting Description 
FST1 / FST2 / FST3 Custom text 
FST*_X / FST*_Y Position 
FST*FONT Font 
FST*FONTSIZE Size 
FST*FONTSTYLE Style 
FST*FONTCOLOR Color 
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Appendix C – Global Variables / Tokens 
These tokens can be used in email subject, body, and card layouts. They are replaced at 

runtime with QSO and QRZ data. 

Contact Information 

Token Description 
<QRZCALL> Contact callsign 
<QRZFNAME> First name 
<QRZLNAME> Last name 
<QRZWNAME> Full name 

Station Information 

Token Description 
<MYCALL> Your callsign 

QSO Data 

Token Description 
<BAND> Band 
<MODE> Mode 
<TIME> UTC Time 
<DATE> QSO Date 
<FREQ> Frequency 
<PWR> Power 
<RSTS> Sent signal report 
<RSTR> Received signal report 

Comments & Text 

Token Description 
<COMMENT> Comment text 

Formatting Tokens 

Token Description 
<LINE_BREAK> Single line break 
<DOUBLE_LINE_BREAK> Double line break 
<BOLD_ON> Start bold 
<BOLD_OFF> End bold 
<ITALIC_ON> Start italic 
<ITALIC_OFF> End italic 
<PARAGRAPH> Paragraph spacing 

 

 

 


